# Table of Contents

Welcome to PowerTeacher Pro! ................................................................. 6  
Navigating PowerTeacher Pro ............................................................... 6  
Migrate Data to PowerTeacher Pro ....................................................... 9  
Quick Start ............................................................................................. 10  
Getting Ready for Report Cards ........................................................... 12  
Tips and Tricks ....................................................................................... 13  
  Compact View ...................................................................................... 14  
  Show/Hide Page Elements .................................................................. 14  
  Scroll Bars Invisible ............................................................................ 14  
  Reports .................................................................................................. 14  
  Associate Assignments ....................................................................... 14  
  Save Toner When Using Print Screen and Printing Report .................. 15  
  Hot Keys ................................................................................................ 15  
Create Categories and Assignments ....................................................... 15  
  Working with Categories ..................................................................... 15  
  Create a Category ............................................................................... 16  
  Working with Assignments ................................................................. 17  
  Create an Assignment ......................................................................... 18  
    Score Types ...................................................................................... 20  
Grading ..................................................................................................... 21  
  Assignments ......................................................................................... 21  
  PowerSchool Learning Assignments .................................................. 24  
    Work with Learning Assignments ..................................................... 24  
  Copy Assignments ............................................................................... 27  
  Copy Scores and Grades ..................................................................... 28  
Importing and Exporting Scores ............................................................ 29  
Enter Scores and Comments .................................................................. 33  
  Summary Area ..................................................................................... 38  
Scoresheet ............................................................................................... 39
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Calculate Assignment Standards Scores</td>
<td>41</td>
</tr>
<tr>
<td>Categories</td>
<td>43</td>
</tr>
<tr>
<td>Traditional Grades</td>
<td>43</td>
</tr>
<tr>
<td>Citizenship Scores</td>
<td>44</td>
</tr>
<tr>
<td>Variable Credit</td>
<td>44</td>
</tr>
<tr>
<td>Standards Grades</td>
<td>44</td>
</tr>
<tr>
<td>Evaluate Standards Grades by Student</td>
<td>46</td>
</tr>
<tr>
<td>Comment Verification</td>
<td>48</td>
</tr>
<tr>
<td>Category Totals</td>
<td>48</td>
</tr>
<tr>
<td>All Reporting Terms</td>
<td>49</td>
</tr>
<tr>
<td>Final Grade Status</td>
<td>49</td>
</tr>
<tr>
<td>Recalculate Final Grades</td>
<td>50</td>
</tr>
<tr>
<td>Class</td>
<td>51</td>
</tr>
<tr>
<td>Class Overview</td>
<td>51</td>
</tr>
<tr>
<td>Students</td>
<td>51</td>
</tr>
<tr>
<td>Students</td>
<td>51</td>
</tr>
<tr>
<td>Student Assignments</td>
<td>52</td>
</tr>
<tr>
<td>Student Standards Progress</td>
<td>53</td>
</tr>
<tr>
<td>Student Standards Progress Graph</td>
<td>53</td>
</tr>
<tr>
<td>Comment Log</td>
<td>55</td>
</tr>
<tr>
<td>Demographics</td>
<td>56</td>
</tr>
<tr>
<td>Quick Lookup - Traditional</td>
<td>56</td>
</tr>
<tr>
<td>Quick Lookup - Standards</td>
<td>56</td>
</tr>
<tr>
<td>Progress</td>
<td>57</td>
</tr>
<tr>
<td>Standards Grades Progress</td>
<td>57</td>
</tr>
<tr>
<td>Standards Progress Report</td>
<td>59</td>
</tr>
<tr>
<td>Traditional Grades Progress</td>
<td>60</td>
</tr>
<tr>
<td>Professional Judgment Indicator</td>
<td>61</td>
</tr>
<tr>
<td>Assessment</td>
<td>62</td>
</tr>
<tr>
<td>Assessment</td>
<td>62</td>
</tr>
<tr>
<td>Reports</td>
<td>62</td>
</tr>
</tbody>
</table>
Working with Reports .................................................................................................................. 62
Individual Student Report ........................................................................................................... 63
Multi-Function Assignment Report ............................................................................................. 66
Scoresheet Report ....................................................................................................................... 67
Student Roster Report ................................................................................................................ 68
Settings ....................................................................................................................................... 70
Student Grade Scales .................................................................................................................. 70
Class Descriptions ...................................................................................................................... 70
    Custom Class Name .................................................................................................................. 71
Comment Bank .......................................................................................................................... 71
Display Settings ......................................................................................................................... 72
Grade Calculation Types ............................................................................................................. 73
Traditional Grade Calculations .................................................................................................... 75
Copy Traditional Grade Calculations .......................................................................................... 76
    Copying Dissimilar Reporting Term Structures ........................................................................ 77
Standards Grades Calculations .................................................................................................... 78
    Standards Calculation Examples .............................................................................................. 78
Welcome to PowerTeacher Pro!

PowerTeacher Pro includes robust functionality for managing the classroom, including advanced features for both standards-based and traditional grading. Teachers use this mobile-friendly gradebook to get their work done quickly and to analyze student performance. Administrators set up district-level grading preferences and apply them to selections of schools to provide grading consistency and to save teachers time. Use PowerTeacher Pro to:

- Create assignment categories
- Create assignments
- Score assignments and work with grades
- Assess student and class performance
- Refine district-level grading preferences

Getting Started

The gradebook is ready to go the first day of school. You don’t have a lengthy setup because its default settings work for most teachers, at least to start. You may want to format certain items, but the default settings make the gradebook fully functional out of the box. Additionally, your district leaders may set up grading preferences for you to provide grading consistency between teachers and schools throughout the district. Navigate to the HTML-based gradebook directly through the PowerTeacher portal. There’s no need to launch a separate application to access PowerTeacher Pro. The first time you navigate to the gradebook, you’ll see a welcome message that introduces some of the features.

Navigating PowerTeacher Pro

Sign In to PowerTeacher Pro

Sign in to PowerTeacher Portal, and then select the PowerTeacher Pro link on the main menu or on the Current Classes page.

Navigation Bar
- Click **Create** to create assignments or assignment categories.
- Click ? to view contextual help, and tips and tricks for using PowerTeacher Pro. Click Getting Started on the Help menu to display the page overlay that provides a high-level introduction to some of the basic features in PowerTeacher Pro.
- Click the silhouette or photo to sign-out of PowerTeacher Pro.

**View Selector**

Click the silhouette or photo and change the **View** in order to expand or compact the view on the page without having to use your browser’s zoom feature. In addition, you can select the gear to show or hide page elements (such as the filter, summary, or standards). Hiding these elements while not in use will increase the number of assignments or students that appear, reducing the need to scroll.

**Class Selector**

Select the class or group of classes to work with from the class selector at the top of the page.

1. Open the class selector.
2. Select a scheduling term to narrow the classes and groups to only classes occurring in that term.
3. On the **Classes** tab, select an individual class to begin working with that class on the current page.
4. On the **Groups** tab, select **All Classes** to work with all of your classes in the selected term. Select a class group to begin working with those classes. The groups are automatically created for classes occurring in the selected term that have the same expression, course, or school (if there are classes at multiple schools).
5. Click the Scoresheet icon to go directly to the **Scoresheet** for a class or group, or select the Progress icon to go directly to the grades progress for a class or group.
6. Click **Settings** to add or change the class description, or to create a custom name for a class. Creating a custom name is helpful when you teach many classes of the same course; you can create custom names to help you easily identify different classes.

**Menu Bar**

Click an item on the menu bar along the left side of the app to open the corresponding section. The image above displays the default menu items for PowerTeacher Pro. Other items that are enabled by your district may appear on the menu bar or on various section menus in PowerTeacher Pro.

**Reporting Term Selector**

Select a reporting term to change the current reporting term that appears in PowerTeacher Pro. **Note:** On the **Assignments** page, **All** appears as an additional option.

**Quick Menu**

Quick Menus are available on pages throughout PowerTeacher Pro. If you see an arrow next to the heading at the top of a page, select it to open the Quick Menu, which provides quick links to other areas of the application.

**PowerTeacher Portal**

PowerTeacher Pro provides links to the PowerTeacher portal. These links are available on the **Students** menu, and from the **Apps** link on the menu bar. You can also select the PowerSchool logo to go directly to the PowerTeacher portal.
Migrate Data to PowerTeacher Pro

PowerTeacher Pro provides a method for you to migrate existing assignments created in PowerTeacher Gradebook (PTG) for the current year.

The following conditions must be met in order to successfully migrate assignment data:

- Your PowerSchool administrator has set the Gradebook Type to **PowerTeacher Pro** for the section for the current year.
- No assignments exist in PowerTeacher Pro.
- Assignments exist in PTG for the current year.

If these conditions are met, the first time you launch PowerTeacher Pro, a Migrate Data to PowerTeacher Pro screen appears.

Click **Migrate**.

- A checkmark appears next to the class when the migration is successfully completed.
- A yellow exclamation marks appears next to the class if data was migrated but changed in some manner from the records in PowerTeacher Gradebook. Look at the Summary tab for more information regarding the failure.
- A red exclamation mark appears next to the class if errors were encountered during the migration.

Click **Summary** to view a log of any migration errors.

Click **Print** to either print the log, or save it as a PDF to send to your PowerSchool administrator.

The following items will NOT migrate from PTG:

- Custom teacher-created versions of the grade scale.
- Custom teacher-created score codes (if there is no corresponding grade scale item or special code item in the grade scale). For example, a teacher enters in score code of “x” = 80%. If there is no “x” in a grade scale or special code, then “x” cannot migrate to PowerTeacher Pro, but the value of 80% is migrated correctly.
- Calculation settings. Since calculation settings do not migrate, be sure that your PowerSchool administrator has created any new grade calculation formulas in PowerSchool, or you can create grade calculation formulas in PowerTeacher Pro.
- Content links
- Teacher-defined custom student fields.
- Classes that are designated as read-only.
For standards, PowerTeacher Pro uses grade scales instead of conversion scales. As part of the PowerSchool 10 upgrade, copies of conversion scales have been created as grade scales and attached to the appropriate standards.

**If assignments do not migrate:**
Assignments that do not migrate will need to be recreated in PowerTeacher Pro.

1. View the assignment details in the **Summary** tab.
2. Find the failed assignments in PowerTeacher Gradebook.
3. Copy the values from PowerTeacher Gradebook into a new assignment in PowerTeacher Pro.

If no assignments migrate successfully for a section, you must create at least one assignment in PowerTeacher Pro to prevent the migration prompt from reappearing. Contact your PowerSchool administrator if you have additional questions.

**Quick Start**

To get started immediately and begin taking advantage of PowerTeacher Pro, perform the following tasks.
For navigation help, see [Navigating PowerTeacher Pro](#).

Get the [PowerTeacher Pro Quick Reference Card](#)!

**Class Descriptions**

You can add descriptions, a custom class name, or other information about the class that will be visible in the PowerSchool Student and Parent Portals, and in PowerSchool Mobile.

1. Use the **class selector** to select a class.
2. If needed, select the term in which the class meets, if different from the current term.
3. On the menu bar, click **Settings**.
4. Choose **Class Descriptions**.

**Display Preferences**

Customize display settings such as class names, how students are sorted, as well as how grades are displayed (traditional vs. standards).
• From the class selector screen, click the Settings link.

Or

• On the menu bar, click Settings, and then choose Display Settings.

Grading Preferences

Define the grade calculations for your classes.

• On the menu bar, click Settings, and then choose Traditional Grade Calculations or Standards Grade Calculations.

Create Categories

Create categories in which you can group similar types of assignments.

• Click +Create and then choose Category.

Create Assignments

Create assignments at the beginning of a school term or at any time during the term.

• Click +Create and then choose Assignment.

Grades

• Enter scores on the Assignment, Scoresheet, or Student pages.
• Use the Score Inspector to provide more details about the student's performance.
• Review all areas of overall class grades on the Traditional Grades, Standards Grades, Comment Verification, Category Totals, and All Reporting Terms pages.

Class Progress

Analyze class performance at any time during the school year.

• On the menu bar, click Progress, and then choose Traditional or Standards.

Reports

You can personalize each report by entering a custom title or by including a top note, bottom note, or signature line.
• On the menu bar, click **Reports**.

## Getting Ready for Report Cards

PowerTeacher Pro provides five powerful features to help you get ready for report cards. Final grades are updated automatically throughout the term as you enter assignment scores. When the term comes to a close, however, you may have additional tasks to perform before submitting grades for report cards to make sure your final grades are accurate. For example, you may have to enter standards grades and modify individual scores. Occasionally, you may also need to modify a student’s final grade in a course based on effort, participation, or other performance factors.

### Traditional Grades

When preparing for report cards, the Traditional Grades page provides an overall view of traditional grades for an entire class, along with a summary of how many absences, tardies, missing, late, and incomplete assignments each student has. Use this page to analyze any correlation between absences and how they may correlate to assignment scores. Use your professional judgment to determine if there is a need to manually override a grade.

• Click **Grading** from the menu bar, or select the **Quick Menu**, and then choose **Traditional**.

### Standards Grades

When preparing for report cards, the Standards Grades page provides an overall view of standards grades for an entire class. Use your professional judgment to determine if there is a need to manually override a grade.

• Click **Grading** from the menu bar, or select the **Quick Menu**, and then choose **Standards**.

### Comment Verification

The Comment Verification page provides you with a view of all comments for a selected class and term. Use this page to review previous comments to aide in your analysis of the final grade.
- Click **Grading** from the menu bar, or select the **Quick Menu**, and then choose **Comment Verification**.

**Category Totals**

The Category Totals page provides an overall view of the category scores for a class. You can analyze student comprehension across all categories for a class. Use this page to review student progress on class work, projects, and tests.

- Click **Grading** from the menu bar, or select the **Quick Menu**, and then choose **Category Totals**. The categories for the selected class appear.

**All Reporting Terms**

The All Reporting Terms page provides a comprehensive view of the traditional grades across all reporting terms for the selected class. This is especially helpful if you use term-based weighting for your final grades.

- Click **Grading** from the menu bar, or select the **Quick Menu**, and then choose **All Reporting Terms**.

**Reports**

- Use the **Individual Student Report** to view details for an individual student. Run the report to display missing and late assignments, assignment due dates, high and low course grades during a specific period, as well as course grade and assignment comments. You can also use this report to see standards progress.
- Use the **Multi-Function Assignment Report** to view assignment details by student. You can sort the report to display only missing and late assignments, or filter it to display specific assignment categories. You can also set a specific date range to view only assignments due within a specific period.
- Use the **Student Roster Report** to generate a report based on student demographic data. You can use this report output for a field trip list, a class contact list, a class checklist, and much more.

**Tips and Tricks**

Get the **PowerTeacher Pro Quick Reference Card** for more quick tips!
Compact View
Show/Hide Page Elements
Scroll Bars Invisible
Reports
Associate Assignments
Save Toner When Printing
Hot Keys

Compact View

To increase the amount of information you can see on a page, use the View selector on the navigation bar.

Show/Hide Page Elements

Click the gear 🛡 to open a menu that allows you to show or hide page elements.

Scroll Bars Invisible

If you are using a Mac, you may not be able to see scrollbars on certain pages of PowerTeacher Pro. This is a feature of the operating system that is easily adjusted. Change the system preferences on your Mac to always display scrollbars. Go to Apple Menu > System Preferences > General, and then set the Show scroll bars setting to Always.

Reports

If you previously used PowerTeacher Gradebook, you may be looking for some of your favorite reports.

- The Student Roster report can be used in place of the Attendance Grid report.
- The Individual Student report can be used in place of the Missing Assignments report.
- The Comment Verification report is available from the Grading menu.
- The Scoresheet report can be exported to Excel.

Associate Assignments

You can easily associate multiple classes to a single assignment, with different due dates, by using the Select Classes menu on the Create Assignment screen.
• You can copy multiple assignments into different classes, and assign relational due dates, by using the Copy Assignments feature.

Save Toner When Using Print Screen and Printing Report

When printing certain pages in PowerTeacher Pro, you can specify in your browser if you want to print background graphics. Printing the background graphics will print detailed information available on these pages. However, you can also avoid printing background graphics on pages to conserve toner. Consult your browser application online help for instructions on printing background graphics. On reports, select the Exclude Row Shading option to save toner when printing reports.

Hot Keys

Use keyboard shortcuts, or hot keys, to enter score flags quickly. Press Enter to view the indicator in the cell.

<table>
<thead>
<tr>
<th>Hot Key Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Co or (.)</td>
<td>Marks an assignment collected.</td>
</tr>
<tr>
<td>La or (*)</td>
<td>Marks an assignment late.</td>
</tr>
<tr>
<td>Mi or (/)</td>
<td>Marks an assignment missing.</td>
</tr>
<tr>
<td>Ex</td>
<td>Marks an assignment exempt.</td>
</tr>
<tr>
<td>Ab</td>
<td>Marks an assignment incomplete due to student absence.</td>
</tr>
<tr>
<td>In</td>
<td>Marks an assignment incomplete.</td>
</tr>
</tbody>
</table>

Create Categories and Assignments

Working with Categories
Categories are broad classifications in which you group similar types of assignments. Examples of categories are homework, tests, and quizzes.

Make a category available to one, some, or all of your classes. For example, if you teach two lab sections, you can create a category for lab work assignments and make the category available for use in only those two sections. When you create assignments for other classes, you will not see the lab work category in the list of available categories.

Your district may also create categories for teachers to use. You cannot delete district-created categories, but if school policy dictates that you use your own categories, or if you do not want to use district-created categories, you can make them inactive.

If a section is shared between multiple teachers, only the lead teacher’s categories will be available for use when working with that section. The Categories page can be used to manage your categories for use with sections where you are the lead teacher.

**Create a Category**

Before you begin creating assignments, it’s recommended that you create categories so you can group assignments by type. Then, set up assignments in PowerTeacher Pro, choose whether or not to include them in the final grade, and tie them to standards if needed.

Your district may also set up assignment categories for you and other teachers to use.

1. On the navigation bar, click **+Create** and then choose **Category**.
2. On the Category tab, select the classes for this category from the Select Classes menu. The default setting is All Classes.
3. Choose/enter category information.
   - Color aligns the selected color with the category and provides a visual representation of the category in PowerTeacher Pro.
   - Active and Inactive makes the category available or unavailable, but does not impact assignments where it has already been used.
   - Description can include detailed information about the category. This information may be shared with administrators, parents, and students. Enter the description of the category using plain text, HTML, or a combination of both. You can also copy content from a Microsoft Word
4. On the Assignment Defaults tab:

- Use the Score Type menu to select the default score type for this category. The fields change specific to your selection. See Score Types. By default, scores in the category will be published to administrators, parents, and students.
- Use the Publish Assignment pop-up menu to select when assignments for this category will publish to PowerSchool for Students and Parents portal. If you chose Days Before Due Date, enter the number of days the assignment should appear prior to the date that it is due in the Days Before Due Date field.
- Select the Publish Scores checkbox is selected by default. Scores for this category will automatically publish to PowerSchool for Students and Parents portal. Deselect the checkbox if you do not want to automatically publish scores for this category.
- To include new assignments in this category in final grade calculations by default, verify that Count in Final Grade is selected.

1. On the View All tab, you can view all active categories. District-created categories are labeled with an icon that looks like a building. View the classes that are using each category, and the status of each category.
2. Click Save.

Working with Assignments

Before you begin creating assignments, at least one category must exist. While your administration may have seeded categories for you, you can also create your own. Set up assignments in PowerTeacher Pro, choose whether or not to include them in the final grade, and tie them to standards. Your district may also set up assignment categories at the district level for you and other teachers to use. See Create a Category.

Before setting up an assignment, consider how you will score the assignment:

- Do you want to record the score as points, a percentage, or letter grade?
- How many points is the assignment worth?
- How do you want to weight the assignment?
- Do you want to include the assignment in final grade calculation?
Count in Final Grade

When setting up assignments, you can use the Count in Final Grade checkbox to indicate whether an assignment should be included in calculating final grades. The value set for a category is used as a default for all assignments within that category, but may be overridden on an assignment-by-assignment basis.

Weighting

Assignment setup may involve weighting; however, weighting is not required. Weighting gives particular assignments, whether points, percentage, or letter grades, more value than others when determining final grades. The weight value is used to multiply the points earned and the points possible.

Extra Points

You can determine the extra points. PowerTeacher Pro takes the total sum of Points Possible and Extra Points to determine the maximum points available on the assignment. When entering the score on the Scoresheet, you cannot enter a value greater than the maximum score that appears on the Assignments window in the Max Entry field.

Note: The maximum point value \((\text{Points} \times \text{Weighting}) + \text{Extra Points}\) for any assignment is 9,999 within PowerTeacher Pro.

Standards Based Grades

You can assign any number of standards to an assignment, which can be scored separately or auto-calculated from assignment scores.

Create an Assignment

You can create one assignment at a time as you progress through the term, or you can set up assignments for the entire term before the term starts. Creating assignments before entering scores does not skew how grades are calculated. The final grade that appears next to a student’s name on the Scoresheet page reflects only the assignments that you have scored already.

1. Click +Create and then choose Assignment.
2. On the Assignment tab, select the classes for this assignment from the Select Classes menu. Classes will default to match the class or group of classes you have selected, but can be changed as needed.

3. Choose/enter assignment information.
   - Use the Score Type menu to select the score type for this assignment. The fields change specific to your selection. See Score Types.
   - To include the assignment in final grade calculations, verify that Count in Final Grade is selected.
   - Click the calendar icon to choose a due date for the assignment. If multiple classes have been selected, use the +Per Class button to define different due dates for each class, if needed.
   - Description can include detailed information about the category. This information may be shared with administrators, parents, and students. Enter the description of the assignment using plain text, HTML, or a combination of both. You can also copy content from a Microsoft Word document and paste it into this field. Use the editing bar to style the description.

4. Click the Students tab to choose only specific students for which this assignment applies, if applicable. By default, the assignment will apply to all students in the selected classes.
   - To apply the assignment to just a selection of students, click Add/Remove Students. Then clear the checkbox next to the Filter area and check the boxes next to the selected students’ names.

5. Click the Standards tab to choose standards to apply to the assignment and whether or not they count in standards grades.
   - Click Show Selected Standards, and then check Auto-Calculate Assignment Standards Scores to automatically calculate standards scores from assignment scores. For more information, see Auto-Calculate Assignment Standards Scores.
   - Click Add/Edit Standards, and check the boxes next to the standards you want to associate to this assignment. Use the Filter field to limit the number of standards that appear. Once the standards are filtered, you can use the checkbox next to the Filter field to select those filtered standards.

6. Click the Publish tab to set when the assignment will be shared with parents and students on the PowerSchool Student and Parent portal.
   - Use the Publish Assignments menu to choose when the assignments will be published.
   - Select the Publish Scores checkbox to share the assignment score.

7. Click Save when finished. You can immediately begin scoring the new assignment by selecting Score Assignment at the top of the screen.
When you save an assignment, **Duplicate** and **Delete** buttons appear on the Edit window. You can copy the assignment you just created, or delete it.

### Create a Duplicate Assignment

To save time, duplicate existing assignments. You can also copy existing assignments to different classes using the **Copy Assignments** feature.

1. Click the **Edit** icon next to the assignment name on the Assignments page.
2. Click **Duplicate**. The Assignment Name is automatically highlighted, and is appended with a number.
3. Edit the assignments details and click **Save**. You can immediately begin scoring the new assignment by selecting **Score Assignment** at the top of the screen.

### Score Types

Choose from four different score types — points, percent, grade scale, or collected only. It's possible to use one score type for one category and a different type for another, but it's best to choose one method and use it consistently when scoring assignments so that your analysis of student performance is easier. When assigning specific score types to a category or assignment, choose from the following scoring options:

<table>
<thead>
<tr>
<th>Score Type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points – Record all scores as points</td>
<td>25 out of 25, 8 out of 10, 50 out of 100</td>
</tr>
<tr>
<td>Percent – Record all scores as percentage values</td>
<td>100%, 80%, 50%</td>
</tr>
<tr>
<td>Grade Scale – Record all scores as values from the grade scale</td>
<td>A, B, F or 4, 3, 1</td>
</tr>
<tr>
<td>Collected Only – Record all scores using the collected score indicator. This type has no score value and therefore does not count toward the final grade.</td>
<td>✔</td>
</tr>
</tbody>
</table>

Once you have set the way scores are to appear in each category, any assignment you create uses that format by default. You can change the default setting when you create individual assignments. Making a decision in advance for categories in general simplifies your gradebook work in the long term.
Grading

Assignments

The Assignments page displays all assignments for the currently selected class or class group. View assignments on both the Assignments and Scoresheet pages. Set up assignments at the beginning of a school term or at any time during the term. When you access PowerTeacher Pro, you see the Assignments page by default. The assignments are listed by the most recent due date by default. Use one of two methods to score an assignment—score a single assignment from the Assignments page or score multiple assignments on the Scoresheet. If your school uses PowerSchool Learning, see PowerSchool Learning Assignments for more information.

View Assignments

1. On the menu bar, click Grading, and then select Assignment List.
2. Click a reporting term. Choose All from the term selector to view every assignment for the selected class or class group, regardless of the due date.
3. Click the gear ⚙, and then choose Show Filter to access the filtering options.
   - Click to add filter settings for the assignment list. Use the pop-up menus to choose the filter options and search operators.
   - Click Needs Scoring to display assignments that are not yet scored. Click Due to display assignments closest to the due date.
   - Click Apply to execute the filter settings.
3. Click a column heading to change the sort order of assignments.
4. Change the View to expand or compact the view on this page.

Metrics

Below the summary section on this page you can view metrics information for assignment scores.
The mean is the mathematical average of the scores you entered. The median represents the middle of all values: one-half of the scores will be above this number and one-half will be below it. The mode indicates the most common value.

All of these values are indicators of how well students do on assignments. If any one of them is unexpectedly low, it may be that students need additional practice on the skills and concepts being assessed, or the assessment needs to be revised.

You can click the gear to show or hide the metrics on the page.

**Copy Assignments**

Click the gear ⚙, and then choose **Copy Assignments**.

**Copy Scores and Grades**

Click on an assignment or score column header to copy and paste scores or grades to a different column for the same class and reporting term, or for a different class or reporting term. Each grade or score is pasted in the destination column for the appropriate student, regardless of the sort order of the list of students or how many students are in both columns.

**Work with Assignments**

1. On the Assignments page, click the **assignment name**. The Single Assignment page appears with the students associated to the assignment.
2. Change to a different assignment by selecting the assignment name and choosing an assignment from the Quick Menu.
3. Click the gear to show/hide different page elements, such as the filter, summary information, and metrics.
4. Click a cell to the right of a student name to display the assignment summary information and the Score Inspector.
Score Single Assignment

1. On the Assignments page, or on the Scoresheet, select the assignment name. The Single Assignment page appears with the students associated to the assignment.
2. Change the View to expand or compact the view on this page.
3. Enter the students’ assignment scores in the Score column. If standards are aligned to the assignment, enter the standards scores in the standards columns. Use the arrow keys on your keyboard or the arrows at the top of the Score Inspector to move to different score cells.
4. Click Save.

Note: If you navigate away from the page before saving scores that you’ve entered, a prompt will appear asking if you want to discard the changes or save them and continue.

Edit Assignment

1. On the Assignments page, or any page with score cells, select the assignment name, and then in the summary area, select Edit Assignment.

OR
On the Assignments page, or any page with score cells, select next to the applicable assignment.
2. Change the View to expand or compact the view on this page.
3. Make any changes needed to the assignment. For more information, see Create an Assignment.
4. Click Save to continue working with this assignment. Click Save and Close to close the screen. Click Delete to remove the assignment.
**Note:** Deleting an assignment will delete the assignment and all associated scores for all classes. If you want to delete an assignment for a single class, remove the class association from the assignment by deselecting the class from the Classes pop-up menu.

**Assignments in a Locked Term**

If a lock icon appears at the top of the assignment column, the reporting term or class is locked. If there are no scores for the assignment in a locked term or class, you can make changes to the assignment details, and move the assignment to a different term if needed. However, if scores already exist for an assignment in a locked term or class, you cannot change the assignment, and you can only copy the assignment to a class or term that is not locked.

**Associate Standards to an Assignment**

Associate standards to an assignment to allow the entry of standards scores on that assignment. When editing an assignment, select the Standards tab and select the standards.

**PowerSchool Learning Assignments**

Using PowerTeacher Pro, you can enter scores, view messages, download attachments, and annotate student work for assignments created in PowerSchool Learning using the Online Work drawer. Learning assignments features are only available if your school has enabled PowerSchool Learning.

**Work with Learning Assignments**

When creating assignments in Learning, be sure to select the correct Display Options to work with assignments in PowerTeacher Pro. The Online Work drawer is only available for Learning assignment activities that have the Display Options enabled for Dropbox and PowerSchool.

In PowerTeacher Pro, you are unable to edit the following fields for Learning assignments:

- Classes
- Assignment Name
- Score Type
- Score Entry Points
- Due Date
- Description
- Auto-Calculate Assignment Standards Scores

Any other assignment fields you modify in PowerTeacher Pro will not be updated in Learning. In addition, assignments created in Learning default to the **Immediately** publish setting. In order to unpublish these assignments, change the setting on the Publish tab of the *Edit Assignment* dialog.

Assignments created in Learning cannot be copied or deleted in PowerTeacher Pro.

**Online Work**

When PowerSchool Learning is enabled, the Online Work column appears when working with Learning assignments.

When viewing the assignment on the *Assignment* detail or *Student* pages, the Online Work column displays a paperclip icon to indicate that online work has been submitted for the assignment. When you mark the attachment as Reviewed or Hand Back, additional icons appear next to the paperclip. The Legend at the bottom of the screen provides information on the different icons that may appear in the Online Work column.

Click the paperclip to open the Online Work drawer. All messages and attached files associated to the assignment appear, with the most recent message at the top.
When an Activity is deleted in Learning, the associated Online Work is removed in PowerTeacher Pro.

To show/hide the Online Work drawer, click the toggle button located on the top of the Score Inspector keypad.

**Annotate Attachments**

In the Online Work section, select a file and a pop-up menu appears. Click **Annotate** to open the annotator, or click **Download** to download the attachment.

When annotating attachments, you can add comments, create markings, or highlight areas of the attachment. You can annotate the following file types:

- .bmp
- .doc
- .docx
- .gif
- .jpg
- .pdf
- .png
- .ppt
- .pptx
- .txt
- .xls
- .xlsx
Use the tools located on the right side of the annotator screen to add elements to the attachment.
Click the Select tool and then click on an existing element to move or delete it.
At the bottom of the screen, click **Reviewed** to mark the attachment as reviewed.
Click **Hand Back**, and a new version of the file is created and appears in the Messages area. The handed back version does not appear in the Online Work area, since the handed back version is no longer available for annotation.

**Messages**

In the Messages section, click the **plus** sign to compose a message. When sent, the message appears at the top of the list in the Messages area.

**Copy Assignments**

You can copy assignments from one class to a different classes in the current or next year. All matching reporting terms will be copied as well.
If you have standards associated to the assignment, the standards are copied along with the assignment details, if the standards already exist in the target school year.
If a lock icon appears at the top of the assignment column, the reporting term or class is locked. You are unable to copy an assignment to a locked term or class.

1. On the **Assignments** page or **Scoresheet** page, click the gear 🛡️, and then choose **Copy Assignments**.
2. In the **From** section, select the Term and Class from which you want to copy assignments.
3. In the **To** section, select the Term and Classes to which you want to copy assignments.
4. In the **Copy Options** section, select how you want to impact the due date for the assignments you are copying.

The options are:

- **Existing** - The copied assignments receive valid due dates relative to the selected term. This option works best when copying into the same term, or overlapping terms.
- **Relational** - The copied assignments receive valid proportional due dates relative to the selected term. The due dates are calculated based on the
start date and end date of the term. This option works best if you want PowerSchool to automatically calculate the due dates for different terms.

- **Custom** - The copied assignments receive a specific due date that you assign. This works best for assignments that you want to repeat multiple times within a term on specific dates.

5. In the Choose the Assignments section, select the box next to the assignments you want to copy, or select the box in the heading (next to **Category**) to select all assignments.

  **Note:** If the source class you selected is a PowerTeacher Gradebook class, all assignments will be copied to the classes you select.

6. Click **Copy Assignments**.

7. Verify the due dates for all assignments you copied. Be sure to review the assignments in each of the target classes and terms.

---

### Copy Scores and Grades

You can copy scores and grades from one column to different columns in the same or different classes and reporting terms. This is useful if you have a student who switches classes, or if you accidentally enter scores or grades for the incorrect assignment or in the incorrect class.

If a lock icon appears at the top of the assignment column, the reporting term is locked. You are unable to copy scores and grades to a locked term. A message appears at the top of the page to inform you if the copy was successful.

Keep in mind the following rules:

- You cannot replace scores or grades that use a different score type than the original.
- The sort order of the list of students does not matter. Pasting a column updates the score or grade for the appropriate student.
- If the list of students is different between the original assignment scores and the assignment being copied to, only scores for students who are in both classes will be updated.
- When entering scores on the **single assignment page**, the **Paste** function is unavailable for an assignment score when the standards calculation is set to use automatic calculation.

1. On the **Assignments, Scoresheet**, or **Standards Grades** page, click on the score or assignment column header, and then choose **Copy**.
2. Locate the assignment or score column you want to replace. Click on the column header, and then choose Paste. All updated scores and grades are highlighted.
3. Click Save.

If you accidentally paste scores or grades into an incorrect column, here's an easy fix:

1. In the column where you incorrectly pasted scores or grades, clear the contents from the first score in the column.
2. On the Score Inspector, click the vertical Fill button to fill all fields in the column with the blank score or grade.
3. Click Save.

---

**Tip:** Here are some examples of how you can use the copy scores and grades feature in your gradebook.

- Copy from one assignment to another: On the scoresheet, if you enter scores for the wrong assignment (source), you can copy the source assignment scores and paste it in the correct assignment score column (if the score type is the same). If the source assignment column where you entered the scores was originally blank, or if it contained scores that you replaced, copy the assignment scores, refresh the page to set the scores back to the original state, then paste the copied scores in the correct column and click Save.
- Copy from an assignment in one term to another: If the score type is the same, you can copy from one assignment to another in different terms, as long as the term you paste the scores to is not locked.

---

**Importing and Exporting Scores**

[Export Scores Template](#)
[Import Scores](#)
[Import a File with Internationalized Characters](#)

You can export information for a single assignment into a comma-separated values (CSV) text file using the PowerTeacher Scores Template (PST).

In addition to the PowerTeacher Score Template, you can also import scores for a single assignment using a variety of file formats from third party applications. If you use your own file format to import assignment score information, at a minimum, the file must
contain a student identifier (school defined student number) column and a score column. You may also include columns like a student name column, or additional score columns (if maintaining assignment score information for several assignments within a given import file).

**Note:** Although the PowerTeacher Pro import function only imports scores for a single assignment at a given time, your import file may contain assignment score information for several assignments.

**Export Scores Template**

Use the Export Scores Template to export an assignment score template with or without scores included. This file can then be used to work on your scores outside of PowerTeacher Pro. Once you are finished recording assignment scores, you can then import the updated information back into PowerTeacher Pro.

1. Select an assignment from the Assignment List.
2. Click the gear and choose **Export Score Template**. If scores exist for the assignment, you can include the scores in the export, or opt to export only the assignment and student information.
3. To view the export scores template, navigate to where the export scores template was saved and open it. The download location is determined by your browser settings.

**User Tip:** If you open the downloaded template using Microsoft Excel for Office 2016, be sure to save it as a .csv file (File menu > Save As > File Format: Comma Separated Values UTF-8 (.csv)) before you import the scores back in to PowerTeacher Pro. If you are using a different version of Excel, contact your PowerSchool administrator for assistance.

**Import Scores**

The basic import function provides you with the required tools needed to bring assignment score information into PowerTeacher Pro. Before performing an import, you must have an import file available containing the data you want to import. If the reporting term or class is locked, you are unable to import scores.

1. Select an assignment from the Assignment List.
2. Click the gear and choose **Import Scores**.
3. Click **Browse Files**, then select the file you want to import.
4. Choose the Format from the pop-up menu.

If **CSV** or **Text** is selected, additional options appear:

- **Include First Row** – select the checkbox if there is not a header row and all rows contain data to be imported.
- **File Score Type** – This is the score type entered in the file you are importing. If the score type of the import file does not match the current score type of the assignment in PowerTeacher Pro, the score will automatically translate to the score-value currently used for the assignment.

For example, if you entered percentages in the import file, and the assignment is configured to use points, select **Percent**. When the file is imported, PowerTeacher Pro will automatically translate the percent values to points.

If **Other** is selected, additional options appear:

- **Field Separator** - enter the character used to separate fields. If left blank, this defaults to a comma.
- **Line Separator** – enter the character used in the import file to designate a line separator. If left blank, this defaults to the end of line mark (carriage return).

---

**Import Tip:** If you are importing a file that includes multiple score columns, select **CSV, Text, or Other**. Multi-column import is not supported with PowerTeacher Score Template (PST).

---

5. Select the **Validate Student Names** checkbox to validate that the student names in the import file match the names enrolled in the class. This is an optional setting to help identify possible mistakes in the import file where the student name does not match the student number.
6. Click **Next**.
7. If alerts appear on the screen, hover over or click the alert icon to see the message at the top of the screen.
8. You can select how you want the import data to appear.
   - If you are importing a PST file and the Assignment Name does not match the one specified on line 3 of the file, you will receive a warning message. To proceed, select the checkbox.
   - Scores already exist: You can keep or overwrite existing scores.
   - Standards scores already exist: You can choose to keep the existing standards scores, or recalculate them based on the imported data.
   - For scores higher than the max value: If the import file contains scores that are higher than the maximum value set for the assignment, you can choose to keep the existing scores, or overwrite them with the maximum value.

When you make a selection from the menus provided, the alert icons are removed if they are resolved by the selection you made.

If you are importing a file with multiple score columns, click on the score column header to select the column to import. If you select a column in which a score exceeds the maximum value for the assignment, you can select to keep the existing scores, or change them to the maximum value for the assignment. This is useful if you happen to have a file set up to have a separate column for multiple assignments. In this case, the first 15 score columns will display for you to pick which score column to import.
9. Click **Import**. The scores appear on the Scoresheet.

**Import a File with Internationalized Characters**

**Note:** The following provides instructions on importing a file with internationalized characters using Microsoft Excel for Office 2016. If you are using a different version of Excel, or you use a different spreadsheet program, contact your PowerSchool administrator for assistance.

If your data contains internationalized characters, you will need to set some parameters for a successful import into PowerTeacher Pro.

1. Open Excel.
2. Choose **Blank Workbook** to create an empty document.
3. On the **Data** tab, click **From Text**, then select the file to import.
4. On the Text Import Wizard:
   a. On the Step 1 screen, choose the Delimited option, and on the File origin menu select **65001: Unicode (UTF-8)**. Click **Next**.
   b. On the Step 2 screen, choose **Comma** as the delimiter, and the double quote character as the Text qualifier. Click **Next**.
   c. On the step 3 screen, click **Finish** to complete the import.

**Enter Scores and Comments**

While you can enter scores or grades directly on the scoresheet, use the Score Inspector to provide more details about the student’s performance. Identify if an assignment is
missing, if it was received late, if it was collected but hasn't been scored or graded yet, if a student is exempt from completing an assignment, if the student didn’t complete an assignment because he was absent, or if it is incomplete for other reasons. Also use the Score Inspector to enter a comment about a student’s score or grade.

1. Comments

As you enter assignment scores or final grades, use comments to record specific details about student performance. Add comments manually or choose comments from the Comment Bank.

Comment Tip: If you previously used PowerTeacher Gradebook, you can import the comments you used in that web gradebook in to PowerTeacher Pro.
To enter comments manually:

1. Select the text field at the bottom of the Score Inspector, or select the Comment icon on the Score Inspector and select the larger text field.
2. Enter comment text. A comment icon appears in the table for the selected field, indicating that a comment exists for that score or grade.

To select comments from the Comment Bank:

1. Select the Comment icon on the Score Inspector.
2. Select the Show Comment Bank button.
3. Select the gear 🛠️, and then choose which Comment Bank you want to appear, either the district comment bank or your personal comment bank. You can also choose if you want comments separated by a line break or a space. Click Manage Options to open the Comment Bank page.
4. To limit the comments that appear in the Comment Bank, enter information in the Filter field and then select Apply.
5. Select the star next to a comment in the bank to set it as one of your favorite comments. You can then sort the list to display your favorite comments at the top of the list.
6. Select the Plus (+) next to one or more comments you want to add to the score. A blue Comment icon appears in the student’s score cell. Click the icon to read the comment.
7. Click Clear Comment to remove the comment from the score.

You can use smart text to automatically insert specific student information—such as the student’s preferred name. For example, if you enter a comment for one student that says, “Richard completed all assignment tasks,” and filled the comment for other students, each student’s name would be personalized in the resulting comments. When you use the Fill functions to fill comments that include smart text, the Names and Pronouns dialog appears to confirm that you want to apply smart text to each comment, or using the original text. Select the smart text link on the dialog to see the smart text codes that can be used. Smart text will include all additional gender pronouns set by the district.
2. Navigation

Use the arrow buttons to navigate to a different student, or to a different score or grade column.

3. Score/Grade

Enter the score or grade in the field, or select the score or grade using the keypad. Select the `<` or `x` button to the right of the score or grade to remove it.

When you modify a final grade, the original calculated grade appears on the Score Inspector directly under the grade input field. A black triangle appears in the upper left corner of the grade, indicating that it has been modified from the original calculation. Select the Undo button to revert to the original calculated grade.

If a student grade scale has been assigned to a student, a message appears just below the score field to alert you that you are working with a grade scale that differs from the overall class grade scale. In addition, an orange triangle appears near the student name, and the grade is highlighted with an orange border.
4. Special Codes

If your PowerSchool administrator has provided special codes, select **Codes**, and then select the applicable special code from the pop-up. The special code and the associated score attribute appears on the Scoresheet. Default special codes are:

- **INC** (Incomplete)
- **ABS** (Absent)
- **MIS** (Missing)

Your PowerSchool administrator may add other custom codes for your use.

5. Grade/Score Flags

Select a flag on the Score Inspector to add it to a grade or score. You can also use **hot keys**, indicated by the two underlined letters below each flag in the score inspector, to add the flag from your keyboard. **Note**: If you have special codes that coincide with the hot keys (for example, **ABS** for absent), you must enter the full special code in order for it to appear in the score field.

6. Fill Grades, Scores, or Comments

Use the Fill functions to either fill grades or scores for one final grade, or one assignment, for all of the students in a class, or to fill all final grades or all assignment scores for just one student.

To fill students’ grades or scores vertically:

1. Select the applicable grade or score cell.
2. Enter the grade or score, select a score flag, or enter a comment in the Score Inspector.
3. Select the Fill icon with the vertical arrows.

4. If a comment exists in the selected field, a pop-up menu appears.
   a. For assignment scores, select **Scores, Flags, and Comments** to fill in all blank score fields for an assignment with the comment, score, and flags you have currently selected on the Score Inspector. For final grades, this option will be called **Grades, Flags, and Comments**.
   b. Select **Comments Only** to fill in all rows that do not currently have a comment. Grades or scores, and flags will not be affected. Only the comment will be filled.

To fill students' grades or scores horizontally:

1. Select the applicable grade or score cell.
2. Enter the grade or score, or select the score flag, or enter a comment in the Score Inspector.
3. Select the Fill icon with the horizontal arrows.

Grades or scores, flags, and comments will be filled in cells that do not already have content. The Comments Only option is not available when filling horizontally.

**Note:** Fill will modify fields that will accept the filled value. For example, if you have a 10 point POINTS assignment and a 10 point PERCENT assignment, filling 10 would score both assignments with 10, so the student would receive a 10/10 for the POINTS assignment and a 1/10 for the PERCENT assignment as it is 10% of the assignment value.

To fill with no content, or clear grades, scores, or comments:

1. Select the applicable grade or score cell.
2. Clear the values in the Score Inspector (for example, remove the value so the grade/score field is blank, deselect the flags, and clear the comment field).
3. Select the applicable Fill icon (vertical or horizontal).

**Summary Area**

The summary area appears on several pages in PowerTeacher Pro, and displays different information based on the page and your selection. It provides at-a-glance information on an assignment, and quick links to view more details.
Assignments Summary

- **Assignment**: Displays the assignment name, and if applicable, the application that created the assignment in parentheses. This indicator allows you to track which integrated application created this assignment.
- **Score Type**: Displays the score type associated to the assignment.
- **Score**: Displays the score, total points and weight, and if it is Exempt from the final grade.
- **Due**: Displays the due date for the assignment.
- **Edit Assignment**: Opens the Edit Assignment dialog.
- **Show More**: Displays the Grade Scale (or [Student Grade Scale](#)) and Special Codes for the assignment.

Traditional Final Grades Summary

- **Class Grade**: Displays the reporting term of the final grade.
- **Grade Scale Type**: Displays the grade scale type (Alpha or Numeric) followed by the range of grades in the scale associated to the selected class.
- **Calculation**: Displays the calculation formula type for the selected class.
- **Grade**: Displays the grade, percent, and/or the points/points possible.
- **Show More**: Displays the Grade Scale (or [Student Grade Scale](#)), Special Codes and Formula used to calculate the final grade.

Standards Summary

- **Class Grade**: Displays the name of the standard associated to the selected standards score or standards final grade.
- **Grade Scale Type**: Displays the grade scale associated to the selected standard.
- **Show More**: Select the link to display the standard description, the standard hierarchy, the associated grade scale, and Special Codes associated to the selected standard.

Scoresheet

Using the Scoresheet page, you can score assignments, and view and edit final grades for students enrolled in a class.
When you select a course grade or score field on the scoresheet, the Score Inspector appears, and summary information for the assignment or grade appears above the scoresheet. If the reporting term or class is locked, you are unable to make changes to final grades (included final grade recalculation) and assignment scores.

1. On the menu bar, select **Grading**, and then select **Scoresheet**.
2. Click **Show Assignments from Most Recent** to sort assignments by date.
   - To view the scoresheet for a group of classes, choose the group from the **Class Selector**, then use the Scoresheet **Quick Menu** to easily switch between the classes within the group.
3. Locate the assignment you want to score, and enter the students’ assignment scores in the **Score** column.
4. If standards are aligned to the assignment, enter the standards scores in the standards columns. Use the arrow keys on your keyboard or the arrows at the top of the Score Inspector to move to different score cells.
5. To change the term, make a selection from the **Reporting Term** menu in the upper right portion of the page.
6. Use the **summary area** to view details or make changes to an assignment.
7. Click the assignment name in the column heading to view a single assignment on the Scoresheet.
8. If you want to see more students on this page, use the **View selector**.
9. Click **Save** when you are done entering scores.

**Metrics**

Below the summary section on this page you can view metrics information for assignment scores and final grades.

The mean is the mathematical average of the scores you entered. The median represents the middle of all values: one-half of the scores will be above this number and one-half will be below it. The mode indicates the most common value.

All of these values are indicators of how well students do on assignments. If any one of them is unexpectedly low, it may be that students need additional practice on the skills and concepts being assessed, or the assessment needs to be revised.

You can select the gear to show or hide the metrics on the page.

**Copy an Assignment**
Click the gear 🏢, and then choose **Copy Assignments**.

**Copy Scores and Grades**

Click on an assignment or score column header to copy and paste scores or grades to a different column for the same class and reporting term, or for a different class or reporting term. Each grade or score is pasted in the destination column for the appropriate student, regardless of the sort order of the list of students or how many students are in both columns.

**Student Grade Scales**

If enabled by the district administrator, you can assign student grade scales that differ from the class grade scale. When a student has a student grade scale assigned, an orange triangle appears next to the student name on the scoresheet.

![Image of student grade scales]

**Auto-Calculate Assignment Standards Scores**

You can select if you want the assignment score to auto-calculate the standards scores.

1. Select an assignment name on the **Assignments** page or the **Scoresheet**.
2. On the **Standards** tab of the Edit Assignment dialog, select the checkbox if you want the assignment score to auto-calculate to standards scores.

**Auto-Calculation Scenarios**

If no calculation preferences are set:

<table>
<thead>
<tr>
<th>Standards Scenario</th>
<th>Alphanumeric Scale</th>
<th>Numeric Scale</th>
</tr>
</thead>
</table>
Using assignment standard scores to calculate the final standards grade

<table>
<thead>
<tr>
<th>Standards Scenario</th>
<th>Alphanumeric Scale</th>
<th>Numeric Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-calculate higher level standards grades from lower level standards grades that all have the same grade scale.</td>
<td>Uses values and cut-offs to calculate the final standards grade. Every letter has a grade value. The scores are calculated to a grade value, then the cut-off is used to determine the final grade.</td>
<td>Numeric scales with no decimals or with extra decimals use numeric value and numeric cutoffs to calculate the standards grade. Or, the scale uses ratios if the PowerSchool administrator has set the grade scale conversion into the numeric scale to use ratios. For example, 9/10 -&gt; 3 cut-off, 9/10 -&gt; 3.3 ratio). For credit in between whole numbers, the cut-off is the discrete value. Numeric scales with decimals use basic numbers with no special values.</td>
</tr>
<tr>
<td>Auto-calculate higher level standards grades from lower level standards grades when some have different grade scales scale.</td>
<td>Uses values and cutoffs to calculate the final standards grade. Every letter has a grade value. The score values are calculated to a higher level standard grade value, then the cut-off is used to determine the final grade.</td>
<td>Uses the grade value and cut-off to use the values and cutoffs grading method.</td>
</tr>
</tbody>
</table>

If preference is set to calculate the higher level standards grades from lowest level standards grades:

If the preference is set to allow assignment scores to auto-calculate the assignment standards scores:
### Standards Scenario

<table>
<thead>
<tr>
<th>Standards Scenario</th>
<th>Alphanumeric Scale</th>
<th>Numeric Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-calculate standard scores from assignment scores.</td>
<td>Uses values and cutoffs to calculate the standards score. Every letter has a grade value. The cut-off is used to determine the assignment standards score.</td>
<td>Uses values and cutoffs to calculate the standards score. Every numeric grade has a percent value. The cut-off is used to determine the assignment standards score.</td>
</tr>
</tbody>
</table>

### Categories

View and work with your categories on the Categories page. District-created categories are labeled with an icon that looks like a building.

If a section is shared between multiple teachers, only the lead teacher’s categories will be applicable when working with that section.

1. If a section is shared between multiple teachers, only the lead teacher’s categories will be applicable when working with that section. Click **Grading** from the menu bar, and then choose **Categories**. All of your active categories appear.
2. Click **Show Inactive** to display categories that are not currently active.
3. Click the arrows to move categories higher or lower on the list to sort the categories.
4. Click next to the category name to edit. Click **Save** when your changes are complete.
5. To delete a category, select next to the category name. Click **Delete**, and then select **Confirm Delete**.

**Note:** You will not be able to delete categories that are linked to any assignment (current or past years). You can mark these categories as Inactive instead.

### Traditional Grades

View the traditional grades for an entire class, along with a summary of how many absences, tardies, missing assignments, late assignments, and incomplete assignments each student has.
Use the **Quick Menu** to navigate to other pages in the Grades section of PowerTeacher Pro.

1. On the menu bar, select **Grading**, and then select **Traditional**.

2. To edit the final grades, select a field in the first column and edit the data in the **Score Inspector**. The grades correspond to the reporting term you select in the **reporting term selector**. To see grades for a different reporting term, select a different term.

3. In the **summary area**, select **Show More** to view further details of the grade.

4. Override any grades on this page as needed. A black triangle appears in the upper left corner of the grade field that was changed.

5. Click **Save**.

**Citizenship Scores**

If citizenship score entry is enabled for your school, enter the score in the Citizenship column.

**Variable Credit**

If variable credit is enabled for your school, you will see two columns on the scoresheet: Attempted and Awarded. You can specify how much credit each student attempted, and how much credit each student is awarded, regardless of the credit hours specified for the course or the grade the student earned for the class in a term.

**Standards Grades**
Teachers select the appropriate standards to be assessed on each assignment. When they enter student scores for the standards on that assignment, PowerTeacher Pro automatically calculates a standards final grade for each student. At any point, you can manually override the calculated standards final grade when appropriate.

The Standards grades page is useful for preparing for report cards. You can view all of the standards grades for all students for a reporting term. You can quickly go through the list of standards grades, and make any changes manually.

Set the Standards Grades Calculations prior to working with standards grades.

Use the Quick Menu to navigate to other pages in the Grades section of PowerTeacher Pro.

1. On the menu bar, select Grading, and then select Standards.

2. Click a standards grade field located to the right of the course grade column, and the summary information displays information about the standard above the table, in addition to activating the Score Inspector.

3. Click Show More to view further details of the standard in the summary area.

4. Override any grades on this page as needed. A black triangle appears in the upper left corner of the grade field that was changed.

5. Click Save.

Copy Scores and Grades

Click on an assignment or score column header to copy and paste scores or grades to a different column for the same class and reporting term, or for a different class or reporting term. Each grade or score is pasted in the destination column for the
appropriate student, regardless of the sort order of the list of students or how many students are in both columns.

Evaluate Standards Grades by Student

1. To evaluate the student's grade, select the grade.

2. On the Score Inspector, click the **graph button** to show or hide the standards progress graph. The progress graph shows how the student performed on the standard over a period of time.

3. Click **Show More** to open the Student Standards Progress page.

4. Click the gear 🛠️ to select additional metrics to graph. The graph is updated based on your selection.

The **Professional Judgment Indicator** alerts you that a student's calculated grade might not align with their proficiency in the standard.

Use your professional judgment to evaluate whether or not the calculated score is a true indication of the student’s level of mastery. For example, if the student was ill or had a bad test day, the last score may not be a true indicator of his skill level, so you could choose to ignore that score and change the calculated score.

**Metrics**
Below the summary section on this page, you can view metrics information for assignment scores and final grades.

The mean is the mathematical average of the scores you entered. The median represents the middle of all values: one-half of the scores will be above this number and one-half will be below it. The mode indicates the most common value.

All of these values are indicators of how well students do on assignments. If any one of them is unexpectedly low, it may be that students need additional practice on the skills and concepts being assessed, or the assessment needs to be revised.

You can select the gear 🛠 on the Scoresheet to show or hide the metrics on the page.

**How do I determine the standards final grade for the marking period?**

The default calculation method is used as a starting point. However, as described above, sometimes these measures work very well, and other times there are reasons to prefer a different calculation. The default calculation is a good starting point. However, the teacher should review the standards grades above, and review the calculations in the summary area below. Then the teacher can determine if the calculated grade is correct for the report card for the student, or if they want to choose a different grade on that standard for that student.

Here are two examples, both of which start with a calculation of the highest score for the final standards grade.

**Student 1**

- Highest = 4.
- Final grade decision on this standard: For this student, 4 is probably a good choice for the final grade on this standard. No change or further work needed.

**Student 2**

- Scores: 2,2,4,2,1,2,2,2,2,2,2,2
- Highest = 4.

Final grade decision on this standard: For this student, it would be good to know more about the time they got a 4. Likely, the teacher will want to change the standard final score on the report card from 4 to 2. Two is the median, mode, approximate mean, and the most recent score. With this data, 2 appears to be a more accurate representation of the student’s actual proficiency level on this standard than 4.
Comment Verification

Use this page when you are getting ready to complete traditional grades for report cards. View all traditional grade comments for a selected class and term. This page provides information similar to the Comment Verification report available in PowerTeacher Gradebook.

1. On the menu bar, select Grading, and then select Comment Verification.

   Use the Quick Menu to navigate to other pages in the Grading section of PowerTeacher Pro.

2. To add or edit a comment, selects a student’s final grade.
3. Click the Comment icon in the Score Inspector.
4. Add comments for additional students.
5. Click Save.

Category Totals

View students’ final grades data, aggregated by category.

Use this page to assess how students performed in one assignment category versus another, or to analyze the difficulty of one category type versus another. For example, if students received significantly lower scores on assignments in the Homework category than in the Test category, you might revisit the homework assignments and analyze the difficulty.

1. Click Grading from the menu bar, and then choose Category Totals. The categories for the selected class appear.

   Use the Quick Menu to navigate to other pages in the Grades section of PowerTeacher Pro.

2. Click Show All Categories to display all available categories. Click Show Categories for this Section to limit the category display to only those associated to the selected section.
3. Click a grade to change the value using the score inspector. A black triangle appears in the upper left corner of the grade field that was changed. Click Save.
**Metrics**

Below the summary section on this page you can view metrics information for assignment scores and final grades.

The mean is the mathematical average of the scores you entered. The median represents the middle of all values: one-half of the scores will be above this number and one-half will be below it. The mode indicates the most common value.

All of these values are indicators of how well students do on assignments. If any one of them is unexpectedly low, it may be that students need additional practice on the skills and concepts being assessed, or the assessment needs to be revised.

You can select the gear to show or hide the metrics on the page.

**All Reporting Terms**

Use this page to work with the final grades for all reporting terms. Each column represents a reporting term. The column that corresponds to the current term is highlighted.

1. Click **Grading** from the menu bar, and then choose **All Reporting Terms**.
   Use the **Quick Menu** to navigate to other pages in the Grades section of PowerTeacher Pro.
2. To edit the final grades, select a grade and edit the data in the **Score Inspector**.
3. Click **Show More** to view further details of the traditional grade in the **summary area**.
4. Override any grades on this page as needed. A black triangle appears in the upper left corner of the grade field that was changed.
5. Click **Save**.

**Final Grade Status**

As you prepare for report cards, you can easily communicate the status of your final grade verification process with your PowerSchool administrator. The administrator can view a report of the status of all final grades verification for the school. The report includes any comments you enter in the verification dialog.

1. Choose the class from the **Class Selector**.
2. Choose the reporting term from the **Term Selector**.
3. On the bottom of the Traditional Grades, Standards Grades, or Comment Verification pages, click **Final Grade Status**.
4. In the dialog, select (term) Final Grades are Complete checkbox, and enter any comments in the field.
5. If you are not ready to verify the final grades for the class, leave the checkbox blank, and enter comments for the administrator in the Comment field. You may want to include information on when you will have the final grades verified.

6. Click **Save**.

### Recalculate Final Grades

Use this feature to recalculate final grades for one or more classes. Although final grades in PowerTeacher Pro are calculated automatically, you can force a recalculation, if necessary. Use the recalculate tool after making significant changes, such as adding multiple assignment scores for students who transferred from another class. Also, recalculate grades when your PowerSchool administrator changes a setting that affects PowerTeacher Pro, such as the grade calculation formula.

If the reporting term or class is locked, grades will not be updated if you recalculate final grades.

1. From the **Grading** menu, select: Scoresheet, Categories, Traditional, Standards, Comment Verification, Category Totals, or All Reporting Terms.
2. From the **Students** menu, select: Assignments, Standards Progress, or Comment Log.
3. Click the gear  🛠️, and then choose **Recalculate Final Grades**.
4. Use the Select Classes menu to select one or more classes.
5. Check the type of grades you want recalculated.
6. Click **Recalculate**.
Class

Class Overview

The Class menu is visible if the school has enabled PowerSchool Learning as the learning management system. This menu allows you to work with Learning directly from PowerTeacher Pro.

My Portal opens the Learning Portal page.

My Classes opens the Learning Classes page.

Pages opens Pages in Learning for the class you have selected in PowerTeacher Pro. If you have multiple classes selected in PowerTeacher Pro, you may be asked to choose which class in Learning you want to open.

Calendar opens the Calendar in Learning for the class you have selected in PowerTeacher Pro. If you have multiple classes selected in PowerTeacher Pro, you may be promoted to choose which class in Learning you want to open.

You can work with various aspects of assignments created in Learning while using PowerTeacher Pro. For more information, see PowerSchool Learning Assignments.

Students

Students

View student progress, manage communication, and work with assignments. Analyze performance throughout the term to ensure that students are mastering the skills and standards you are teaching. Review students’ performance as you prepare to complete final grades for report cards, and then use the gradebook to prepare for and conduct parent-teacher conferences.

Other pages in PowerTeacher Pro are optimized to display how an entire class is performing using the Progress pages. The individual student pages, however, provide more detailed information on an individual student. This is particularly useful for entering multiple of scores for a single student, and during parent-teacher conferences to explain why a student earned a particular grade.
1. On the menu bar, select **Students**.
2. Search for a student using the search field. Use the selection buttons to limit the search to a class or all classes for the teacher.
3. Select a Student View from the menu. The details for the student highlighted in the Students list appears.

   Use the **Quick Menu** to navigate to other pages in the Students section of PowerTeacher Pro.

4. To view only dropped students, select **Show Dropped**.
5. Select a student name to view details for that student.

### Student Assignments

View a summary of the student’s grades and assignments for the selected reporting term.

1. On the menu bar, select Students. Locate the specific student and then select **Assignments**. View a summary of the student’s course grades at the top of the page.
2. Click **Filter** to access the filtering options.
   
   o  Click to add filter settings for the assignment list. Use the pop-up menus to choose the filter options and search operators.
3. Click **Apply** to execute the filter settings.
4. Click a column heading to change the sort order of assignments.
5. Click an assignment name to view assignment scores for the class.
6. Click a cell to display the assignment summary information and the **Score Inspector**. When you change a score, it is highlighted to indicate that it has changed.
7. Click **Save**.
8. If there are Standards associated to the assignment, select the **Standards** icon to view the Assignment Standards Detail.
9. Use the Quick Menu links (the arrow next to the page heading) to navigate to other pages in the Students section of PowerTeacher Pro.
**Student Standards Progress**

The Standards Progress page shows the student’s standards grades for each standard that was assessed by reporting term. The column that corresponds to the selected reporting term is highlighted. Compare the grades the student received in each term to assess his or her progress.

1. On the menu bar, select **Students**. Locate the specific student and then select **Standards Progress**.

2. Click a cell to display the standards summary information and the **Score Inspector**. When you change a grade, it is highlighted to indicate that it has changed.

   The **Professional Judgment Indicator** alerts you that student’s calculated grade might not align with their proficiency in the standard.

4. Click **Save**.

5. To view the assignments that you used to assess the standard, click the icon in the **Assignments** column. Use the graph at the top of the page to see how the student performed over time on the standard. Learn more about the **Standards Progress graph**.

6. To view the student’s performance on additional standards, open the **Quick Menu** and select a standard.

**Student Standards Progress Graph**

The standards progress graph page shows how the student performed over time on the standard.

For example, if the standard was assessed on five assignments, you can see the five standards scores the student received. If the calculation method is set to the three most recent scores, you can see those scores in green on the graph and a dotted line that represents the calculated score.
If you have selected a higher-level standard, that standard and up to three of the directly associated lower-level standards appear. If you chose a lower-level standard, only that standard appears by default.

In the Standard Grade area, you can opt to show or hide a summary of the standards metrics:

- **Most Recent X** – The weighted average of the most recent standard score(s) where X is the number of scores defined in Settings > Standard Grade Calculations
- **Mean** – The average of the standard scores
- **Median** – The middle of the standard scores (half of the scores are above this number and half are below)
- **Mode** – The most common standard score achieved. In the event of multiple modes, PowerTeacher Pro selects the highest value.
- **Wt. Mean** – The average of the standard scores based weighted by assignment total value (points possible x weight).
- **Highest** – The highest standard score

These statistical values are indicators of how well the student did on a specific standard. If any of the values are low, it may mean that the student needs additional practice on the skill or concept you’re assessing, or you may need to revise the assignment.

In the summary area, select Show More to view further details of the assignment or standard.

**Change the Standard View**

Use the Quick Menu to change to a different standard.

**Graph Additional Metrics or Standards**

1. Click ⚙️, and choose Progress Options.
2. Use the drop-down menu next to the gear to select a metric to graph in order to compare an additional metric against the set metric in the calculation for the standard. A dotted line appears on the graph to represent the additional metric.
3. Check the boxes for the standards you want to graph to compare multiple standards. You can select a maximum of three standards to graph in addition to the currently selected standard.
4. Click OK to close the screen.
5. On the graph page, select the standard grade field directly below the graph to focus on that standard.
6. If multiple graphs appear on the page, select to show or hide the additional standard graphs.

Change a Score

Select a score on the graph, or a Standard Score field, and the Score Inspector appears. Change the score as needed, and then select Save. If you change the Standard Grade, a black triangle appears in the upper left corner of the grade field to indicate that the grade has been manually changed.

Comment Log

Use this page to review all comments entered for a student. Depending on the types of comments you’ve entered for the student, the comment log may show course grade comments, standards grades comments, and assignment score comments.

1. On the menu bar, select Students. Locate the specific student and then select Comment Log.
2. Click Filter to access the filtering options.
   o Click to add filter settings for the assignment list. Use the pop-up menus to choose the filter options and search operators.
3. Click Apply to execute the filter settings.
4. Click a column heading to change the sort order of comments.
5. Click a Grade/Score field to display the assignment summary information and the Score Inspector. Click the Comment icon on the Score Inspector to change the comment.
6. Click Save.

Demographics

This page shows the student demographic information as entered in PowerSchool. On the menu bar, select Students, and then select Demographics.
Use the Quick Menu links (the arrow next to the page heading) to navigate to other pages in the Students section of PowerTeacher Pro.

Quick Lookup - Traditional

This page is the same page that parents, students, and administrators see in PowerSchool and, if configured to do so by an administrator, shows the student’s attendance for the last two weeks, the current schedule, current grades, a summary of total absences and tardies, and current GPA.
If the student is enrolled in classes at more than one school, you will see a tab for each school - the home school and all other schools. The first tab displays the student’s home school.
1. On the menu bar, click Students, and then select Quick Lookup - Traditional.
   Use the Quick Menu to navigate to other pages in the Students section of PowerTeacher Pro.
2. Click a grade to view additional details.

Quick Lookup - Standards

This page is the same page that parents, students, and administrators see in PowerSchool and shows the student’s standards grades for all classes in the selected year.
1. On the menu bar, click Students, and then select Quick Lookup - Standards.
Use the **Quick Menu** to navigate to other pages in the Students section of PowerTeacher Pro.

2. Click a grade to view additional details, including the standards grade rollup. In cases where the same student is being assessed on the same standard (for example, Scientific Principles) in different classes at the same time (for example, Q1), the standards grades for each individual section are retained. In addition, they are averaged together to produce a rollup score. The high score is also stored.

## Progress

### Standards Grades Progress

The graph on the Standards Progress page shows the distribution of grades for each standard aligned to the course, for the selected class and reporting term.

If you are working with standards, this is the primary page you can use to manage standards and student progress for your class. The page provides an overall view of the standards for the class. From the Standards Progress page, you can assess which standards you may need to focus on to assure proficiency for the students in your class.

1. On the menu bar, click **Progress** and then choose **Standards**. The grade distribution graph for each standard appears.

2. Use the **class selector** to change to a different class, or to select a class group.

All of the standards aligned to the class are listed in the Standards column. To the right of each standard, view a graph that displays the distribution of scores for the class. The colors in the graph correspond to the grade scale color levels. For example, if the grade scale defines the standard score 4 as dark green, the graph displays a dark green bar that corresponds to the number of students who have a 4. The black demarcation line shows where the cutoff is between passing and failing grades. The numbers above the colored bars show the total number of students who have passing grades versus the total number of students who have failing grades.
The graphical display makes it easy to see whether or not students in the class are demonstrating mastery of the standard, and helps you consider your instructional response. If, for example, you find that most of the students have failing scores, you may decide to reteach the concept or provide more opportunities for practice.

3. Select a grade distribution graph to view the Standards Grades Distribution screen.

On the left side of the Standard Grades Distribution screen, view the grade distribution for the selected standard for each reporting term in the school year. On the right, view the grade trends of the students in the class for the selected term, compared to the previous term to see which students have mastered the standard and which ones need more practice.

4. Click and then select the Show Trend box. Deselect the Show Trend box to hide the trend column. Select the term you want to compare against. If you are working with multiple classes, you can select if you want the class grouped by student or by class on this screen.

5. Click a Score Distribution chart on the left to view the final grades and trend comparison. Arrows indicate if the grades are trending up or down against the selected comparison term. Be careful about comparing against future reporting terms.

6. Click OK to close the screen.

On the Standards Progress page, the number in the Assignments column indicates the number of assignments that you have used for the standard.

7. Click the Assignment icon to view the Standards Assignments Trend screen. The Score Type column displays the calculation method, the total value, and the weight. Click a column header to sort information. Click an assignment to view or edit a score.

8. Click OK to close the screen.
Standards Progress Report

Use the Individual Student Report to generate a standards progress report for a student.

1. On the menu bar, select Reports and then choose Individual Student Report.
2. On the Criteria tab, enter a report title.
3. Open the Select Classes menu and choose the classes to include on the report. You can select single classes, multiple classes, or a class group.
4. If you have created a Custom Class Name, select the checkbox to add it to the report output.
5. Select the Include Students' Full Schedule checkbox to include a full class schedule for each student.

Note: To protect the report from being too large, when you select Include Students' Full Schedule, the following conditions apply:
- By default, the Separate Report box is selected and cannot be deselected.
- In the Layout menu, By Section, By Student is not available.
- In the Areas to Include menu, Assignments Standards Scores and Category Totals are not available.
6. In the Sort Options section, choose how you want to sort information on the report.
   - Click By Section, By Student to sort by section and then by student for each section. This option is not available if you selected to Include Student's Full Schedule. If Separate Report is selected, this option will create one PDF file for each section. This option is not available if you selected to Include Student's Full Schedule.
   - Click By Student to sort by student across all sections. If Separate Report is selected, this option will create one PDF file for each student for each section.
7. Open the Students menu and choose how you want the students sorted on the report. The Gradebook Preference option defaults to the selection you made on the Display Settings page.
8. Open the Assignments menu and choose how you want assignments sorted on the report.
9. In the Data section, open the Select Data menu and choose the data to include on the report.
   - Click Standards Final Grades.
   - Click Assignments, then select Standards Scores. This option is not available if you selected Include Student's Full Schedule.
Note: In order to protect the report from being too large, when standards are selected, the Separate Report checkbox is selected by default.

10. In the Data section, select Include Standards Identifier to include it on the report.
11. In the Date Range section, select the report term for the Standards/Final Course Grades and the Assignment Date Range.
12. Select additional Data Filters as needed.
13. Click the Students tab. If you want to run the report for a subset of students, select Add/Remove Students and use the Filter field to search for specific students. Uncheck the boxes next to the students you want excluded from the report.
14. Click the Format tab to specify how you want the report to look.
15. Click Run Report. When using most browsers, the file automatically downloads to the folder you have designated on your computer. When using Safari browser, the report output appears in a window. Choose File > Export as PDF to download the report to your computer.

Traditional Grades Progress

The graph on the Traditional Grades Progress page shows the distribution of grades for the class for the selected reporting term. It also shows the aggregate totals for missing, late, or incomplete assignments, as well as grade scale information.

This page provides a graphical view of the grade distribution across the selected class. The column on the left lists the number of students who have earned each traditional grade in the grade scale. The colors in the graph correspond to the grade scale color levels. For example, if the grade scale defines the grades A and A- as dark green, the graph displays a dark green bar that corresponds to the number of students who have
an A or A-. The black demarcation line shows where the cutoff is between passing and failing grades. The numbers in the column on the right show the total number of students who have passing grades versus the total number of students who have failing grades.

To the right of the graph, view a summary of the total number of students who have missing, late, or incomplete assignments.

1. On the menu bar, select Progress and then choose Traditional. The class grades progress appears in a graph.
2. Use the class selector to change to a different class, or to select a class group.
3. Click Missing, Late, or Incomplete to view the Traditional Grades page with summary information on each category.

3. Click the information icon to view details of the associated grade scale.
4. Click View All to view the Traditional Grades Distribution screen. Students who have a custom grade scale association are indicated by an orange triangle in the upper right corner of the student name field.
5. Click and then select the Show Trend box. Deselect the Show Trend box to hide the trend column. Select the term you want to compare against. If you are working with multiple classes, you can select if you want the class grouped by student or by class on this screen.
6. Click a Grade Distribution chart to view the final grades and trend comparison. Arrows indicate if the grades are trending up or down against the selected comparison term.
7. Click OK to close the screen.

### Professional Judgment Indicator

If you work with standards grades, the Professional Judgment Indicator is designed to assist you in assessing standards grades.

The indicator helps you understand which grades to focus on to determine if the final grade accurately reflects the student’s level of understanding.

Here’s an example of when the indicator appears:

The most recent scores for a standard are 1, 1, 1, 4, and 4, respectively, and all have different metrics. The Professional Judgment Indicator appears on the calculated final grade field to bring to your attention to the fact that one of the three most recent scores is actually higher than the final grade.
Using your professional judgment, you can decide how you want to impact the final grade. You may override the final grade, or you can make the score anomaly exempt.

**Assessment**

The Assessment charm is available if your district has purchased and enabled PowerSchool Assessment and/or PowerSchool Analytics. PowerSchool Assessment and PowerSchool Analytics provides standards-based instructional assessment solutions for school districts that allow administrators and teachers to deliver measurable improvements in student performance.

The links described below provide direct access to functions within PowerSchool Assessment. PowerSchool Assessment and PowerSchool Analytics launches in a separate window or tab, depending on your browser settings. Be sure to sign-out of PowerSchool Assessment or PowerSchool Analytics when you are finished.

- **Manage Tests** - Access the Assessment Library.
- **Administer Test** - Access the Testing Center.
- **View Results** - Access Assessment Reporting.
- **Assessment Home** - Access the Assessment Home Page.
- **Manage** - Access Interventions.

Additionally, the following links may appear on the Reports charm.

- **View Results** – Access Assessment Reporting.
- **Achievement Records** – Access Student Achievement Records.
- **Longitudinal Data** – Access Longitudinal Data System Reporting (appears if PowerSchool Analytics is enabled).

For more information on using these areas within PowerSchool Assessment and PowerSchool Analytics, consult the PowerSchool Assessment and PowerSchool Analytics online help.

**Reports**

**Working with Reports**
PowerTeacher Pro offers a selection of reports to assist you in daily classroom activities, as well as with assessing student performance. You can generate reports for all students who are enrolled in a class, for all students who are enrolled in all your classes, or for specific students.

**Learn More**
- **Individual Student Report**
- **Multi-Function Assignment Report**
- **Student Roster Report**

## Individual Student Report

This is a multi-function report you can generate that is organized by student. You can generate this report to compile the following information:

- Progress reports
- **Missing and late assignments**
- **Standards final grades and assignment standards scores**
- Grades
- Citizenship
- Category totals
- Assignment scores
- Comments
- Summary of student work to present to parents at conferences or to a principal during a review
- Midterm update for students and parent

This report displays all sections accessible by you. However, the name of the Lead teacher for each class displays on the report.

1. On the menu bar, select **Reports** and then choose **Individual Student Report**.
2. On the **Criteria** tab, enter a report title in the field provided.
3. Open the Select Classes menu and choose the classes to include on the report. You can select single classes, multiple classes, or a class group.
4. If you have created a **Custom Class Name**, select the checkbox to add it to the report output.
5. Select the **Include Students' Full Schedule** checkbox to include a full class schedule for each student you select for a specified term.
• When this option is selected, other Sort Options and Data fields are unavailable. For more information, see Standards Progress Report.
• When this option is selected, if you have opted to show pre-registered students, they will appear on the report.

Report Tip: Use the Include Students’ Full Schedule checkbox to generate a report similar to the Multi-Section Report in PowerTeacher Gradebook. Using the other options, you can generate the report to show scores by assignment, and the final grade for each reporting term, listed on one or multiple pages per student. It gives you the student scores for any class the student is taking.

6. In the Sort Options section, choose how you want to sort information on the report.
   • Click By Section, By Student to sort by section and then by student for each section. This option is not available if you selected to Include Student’s Full Schedule. If Separate Report is selected, this option will create one PDF file for each section.
   • Click By Student to sort by student across all sections. If Separate Report is selected, this option will create one PDF file for each student for each section.

7. Open the Students menu and choose how you want the students sorted on the report. The Gradebook Preference option defaults to the selection you made on the Display Settings page.

8. Open the Assignments menu and choose how you want assignments sorted on the report.

9. In the Data section, open the Select Data menu and choose the data to include on the report.
Additional menus appear on the page depending on the selections you make to allow you to further refine the report. The current default settings are listed on the menus or next to them. If you are including Standards Final Grades or Assignments Standards Scores in the report, the Separate Report checkbox is selected by default. For more information, see the Standards Progress Report.

**Report Tip:** To generate a report of missing assignments, Select Assignments from the Areas To Include menu, and then select Missing from the Assignment Attributes menu in the Data Filters section.

**Report Tip:** To help with identifying students with the same name, select Include Student Number with Student Name to add the student number on the report output.

10. Click the Students tab. If you want to run the report for a subset of students, select Add/Remove Students and use the Filter field to search for specific students. Uncheck the boxes next to the students you want excluded from the report. Select the Include Dropped Students checkbox if you want to include dropped students on the report.

**Note:** If you select Include Students’ Full Schedule and you also selected Include Dropped Students, the report will display the full schedule for dropped students in the selected classes.

12. Click Run Report. When using most browsers, the file automatically downloads to the folder you have designated on your computer. When using Safari browser,
the report output appears in a window. Choose **File > Export as PDF** to download the report to your computer.

## Multi-Function Assignment Report

This report provides a list of students and scores organized by assignment. You can generate this report to compile the following information:

- Missing, late, or incomplete assignments
- Grades
- List of all assignment and the associated scores, flags, and grade for each reporting term, by student.

Use this report to help students and parents keep up with class work, to target students who need extra help, or to gauge which assignments present the most challenges to students.

1. On the menu bar, select **Reports** and then choose **Multi-Function Assignment Report**.
2. On the **Criteria** tab, enter a report title in the field provided.
3. Open the Select Classes menu and choose the classes to include on the report.
4. In the Sort Options section, open the Students menu and choose how you want the students sorted on the report. The Gradebook Preference option defaults to the selection you made on the **Display Settings** page.
5. Open the Assignments menu and choose how you want assignments sorted on the report.
6. In the Data section, select the data to include on the report. **Note:** Select the **Show Assignments with no Data** checkbox to display students who have no score entered for an assignment.
7. In the Date Range and Data Filters sections, use the menus to further refine the report.
• Select the Manual date range to set a specific date range for the assignment.
• Select the Assignment Attributes, such as Missing, Late, Collected, etc.
• Select the Assignment Scores. Based on your selection, additional fields appear.
• Select the Assignment Categories.

8. Click the Students tab. If you want to run the report for a subset of students, select Add/Remove Students and use the Filter field to search for specific students. Uncheck the boxes next to the students you want excluded from the report.

9. Click the Format tab to specify how you want the report to look. You can enter text that you want to appear on the report in the Top Note and Bottom Note fields.

10. Click Run Report. When using most browsers, the file automatically downloads to the folder you have designated on your computer. When using Safari browser, the report output appears in a window. Choose File > Export as PDF to download the report to your computer.

Scoresheet Report

Run the Scoresheet report to generate a spreadsheet-style summary of student grade and assignment data. You can use this report to view final grades for all reporting terms and assignments that are within a specific date range, for all students.

1. On the menu bar, select Reports and then choose Scoresheet Report. On the Criteria tab, enter a report title in the field provided.
2. Select the classes and student field to include on the report from the provided menus.
3. In the Sort Options section, open the Students menu and choose how you want the students sorted on the report. The Gradebook Preference option defaults to the selection you made on the Display Settings page.
4. In the Items to Include section, choose the categories, final grades, and date range to include in the report.
5. Select the Students tab. Select Include Dropped Students to show dropped students on the report. If you want to run the report for a subset of students,
select **Add/Remove Students** and use the Filter field to search for specific students. Uncheck the boxes next to the students you want excluded from the report.

6. Select the **Format** tab to specify how you want the report to look.

- Select the Output type of **PDF** or **Excel**.
- You can enter text that you want to appear on the report in the Top Note and Bottom Note fields.

7. Select **Run Report**. When using most browsers, the file automatically downloads to the folder you have designated on your computer. When using Safari browser, the report output appears in a window. Choose **File > Export as PDF** to download the report to your computer.

---

**Student Roster Report**

This report displays student demographic information, listed one row per student. You can use this report to generate a list of demographic information by class. By adding blank columns and naming them to fit your needs, you can use this report to keep track of money collected for classroom field trips, or as an emergency contact list.

---

**Report Tip:** If you previously used the Attendance Grid report in PowerTeacher Gradebook, you can now use the Student Roster report to create a grid of students with blank columns in order to take attendance offline for a field trip, assembly, our outside activity.

1. On the menu bar, select **Reports** and then choose **Student Roster Report**.
2. On the **Criteria** tab, enter a report title in the field provided.
3. Open the Select Classes menu and choose the classes to include on the report.
4. In the Sort Options section, open the Students menu and choose how you want the students sorted on the report. The Gradebook Preference option defaults to the selection you made on the Display Settings page.

5. Open the Columns menu to select the columns you would like added to the report output.

- Select **Blank** to add custom columns you can use on the printed report to record attendance or participation.
- Enter the column names you want to appear on the report output in the fields provided. Use the arrows to move the columns to the order you want them to appear on the report output.
- Select the arrow buttons to reorder the columns.

6. Select the **Students** tab. If you want to run the report for a subset of students, select **Add/Remove Students** and use the Filter field to search for specific students. Uncheck the boxes next to the students you want excluded from the report.

7. Select the **Format** tab to specify how you want the report to look.

- Depending on the report, you can select the Output type of **PDF** or **Excel**.
- You can enter text that you want to appear on the report in the Top Note and Bottom Note fields.
8. Select **Run Report**. When using most browsers, the file automatically downloads to the folder you have designated on your computer. When using Safari browser, the report output appears in a window. Choose **File > Export as PDF** to download the report to your computer.

**Settings**

**Student Grade Scales**

If enabled by your district administrator, you can apply a grade scale to students that differs from the overall grade scale used for the class. When you assign a custom grade scale to a student, an orange triangle indicator appears next to the student's name on the scoresheet, and the **score inspector** displays a message indicating that the student has a custom grade scale assigned.

In addition, the orange triangle indicator appears in the **summary area** when a student grade scale is in use.

1. On the menu bar, select **Settings**, and then choose **Student Grade Scales**.
2. Click the arrow next to the class name to expand the class view. Any student grade scales already exist for the class appear. If no grade scales exist, a message appears.
3. Click **Add**.
4. On the Choose Students and Grade Scales dialog, select the grade scale from the menu.
5. Use the Filter field to reduce the list of students. For example, type "A" to reduce the list to only students with the last name that begins with "A".
6. Select the checkbox next to each student you want to use the selected grade scale. Click the checkbox at the top of the column to select all.
7. Click **Save**.

**Class Descriptions**
You can add descriptions or other information about the class that will be visible in the PowerSchool Student and Parent Portals, and in PowerSchool Mobile. Examples include grading policy, class syllabus, links to class resources, and more.

If a lock icon appears next to the class name, all reporting terms for the class are locked. You are unable to update the class description or custom class name.

1. From the Class Selector select the scheduling term and class or group for which you would like to edit descriptions.
2. Select the term in which the class meets, if different from the current term.
3. On the menu bar, select Settings and then choose Class Descriptions.
4. Enter the class description, syllabus, or other details in the Description field. You can also copy content from a Microsoft Word document and paste it into this field. Use the editing bar to style the description.
5. Click the arrow to the left of another class name to open the details pane and add a description.
6. Click Save.

**Custom Class Name**

Customize the class name to help you with your classroom management. For example, if you have multiple Biology classes that include the same Course Name, you can customize the names to be different from each other. Use the Custom Class Name field to enter a name for the class that will only appear in your PowerTeacher Pro gradebook. Co-teachers, or students and parents will not see this custom name.

You can choose to include the custom class name in your PowerTeacher Pro reports. Check the Use Custom Class Name checkbox when selecting the report criteria to display the Custom Class Name on the report.

**Comment Bank**

The Comment Bank displays personal comments and comments added at the district. Add comments to the Comment Bank that will be available when adding scores and comments to assignments and final grades. You can also edit and delete previously entered comments. Click the District Comments tab to view comments entered by the district.

Smart Text options allow you to add names or pronouns to the context of the comment. These options allow you to personalize general comments by student. For example,
<first name> listens well in class. <He/She> participates in class discussions will display as Kate listens well in class. She participates in class discussions.

Click the gear ⚙, and then choose Show Filter to access the filtering options.
To add a comment to your personal Comment bank:

1. On the menu bar, select Settings, and then select Comment Bank.
2. Click the My Comments tab.
3. Click Add.
4. Enter a comment code and category.
5. The Favorite checkbox is selected by default to mark this comment as a favorite. Deselect the checkbox to remove this comment from your favorite list.
6. Enter the text of the comment. Click a Smart Text option from the pop-up menu to insert a name or pronoun into the context of the comment.
7. Click Save. The changes or additions appear in the Comment Bank on the Score Inspector.

To modify a comment, click Edit.
To remove a comment, click Edit, then click Delete.

Favorite Comments

On the My Comments or District Comments tab, click on the star to mark the comment as a favorite. Favorite comments appear at the top of the comment list on the Score Inspector.

Import Comments from PowerTeacher Gradebook

If you previously used PowerTeacher Gradebook, you can import the personal comments without having to manually enter them in PowerTeacher Pro. Before you create any comments in your personal comment bank in PowerTeacher Pro, you can perform a one-time migration of your PowerTeacher Gradebook comments to PowerTeacher Pro. If you have already created any comments in PowerTeacher Pro but would like to migrate your PowerTeacher Gradebook comments, delete the comments in PowerTeacher Pro to access the PowerTeacher Gradebook migration option.
On the Comment Bank page, click Import my PTG Comments.

Display Settings

Choose how you want information to appear in PowerTeacher Pro.
1. On the menu bar, select **Settings**, and then select **Display Settings**.
   - Open pop-up menus by selecting ⬇️.
   - Select a box to add a checkmark and activate the setting ✅.

2. Use the Display and Sorting menu to sort the class names.

3. Check **Show Standards Pages and Links** to use the standards grading features.

4. Check **Show Standards on Assignments** to show standards aligned to assignments.

5. Use the Auto-Calculate Assignment Standards Scores menu to determine the default setting for new assignments. Click **New Assignments Start Checked** to have the setting checked by default for all newly created assignments.

6. Use the Navigation Links Sort Order menu to change the sort order of the Traditional and Standards navigation links in the Grading menu and Quick Menu. The default setting is Traditional, Standards.

7. Check the pages on which you want the **Professional Judgment Indicator** to appear.

8. Check **Show Traditional Grade on Pages** to display traditional grades in the gradebook.

9. Use the Values to Show in the Traditional Grades Column menu to select the grade values you want to appear.

10. Under Student Names, use the Display menu to define how students’ names will appear, such as by first, then last name.

11. Use the Sort Students by menu to choose how to sort the lists of students, such as by first name.

12. To view new students’ names at the bottom of class lists, check **Add newly enrolled students to the bottom**.

13. To conceal the names of pre-registered students from class lists, check **Hide pre-registered students**.

14. Click **Save**.

**Grade Calculation Types**

Use calculation formula sets to define the final grade calculation methods—how you want students’ assignment scores to count towards their final grades. Choose whether you’ll calculate the students’ final grades using total points, term weighting, standards weighting, or category weighting. You can combine calculation
methods by using different methods for different reporting terms, such as total points for Q1 and Q2 and term weighting for S1.

**Total Points**

Use the total points method to calculate a student’s final grade by dividing the points the student earned for the class by the number of points possible for the class. Using this option, a student might earn 1250 points out of a total 1600 points possible which would be converted to a percentage of 78% and a grade would be determined from the cutoff percentage defined in the grade scale.

**Term Weighting**

Use the term weighting method to calculate a student’s final grade based on grades from shorter reporting terms. For example, you might calculate the Semester 1 grade based on the final grades for Quarter 1 and Quarter 2. In this scenario, you might enter 40% for Quarter 1 and 60% for Quarter 2. Each percentage is a weight used to determine how the smaller term contributes to the final grade.

**Note:** Only reporting terms that are fully encompassed by the selected reporting term will appear in the list. This option will not appear if the reporting term does not encompass other reporting terms. For example, quarters can usually be used to calculate semester grades.

**Standards Weighting**

To have a standards final grade count in the course final grade for a reporting term (whether Q1, Q2, or S1), you must use standards weighting. Use the standards weighting method to calculate a student’s course final grade based on final grades from the standards aligned to the course. Set up standards weighting similar to how you set up term weighting by defining the percentage that is the weight used to determine how the standards grades contribute to the final grade. For example, you might calculate the Semester 1 final grade based on 40% of the standards grades from Q1 and 60% of the standards grades from Q2. Using Standards Weighting with attributes of Specific Weights and Specific Sum require that PowerSchool administrators configure weights for specific standards for each course on the Course Settings page.

**Note:** Certain weight settings are determined by the PowerSchool administrator, such as Specific Weights and Specific Sum.

**Category Weighting**
Categories are broad classifications for assignments, such as homework and tests. Use the category weighting method to calculate a student’s final grade using assignment categories. Assign a weight to each category to determine how it contributes to the final grade. The rounded percentage the student earns for each category is multiplied by the weight. The weighted percentage values are added together to calculate the final grade. For example, you might use the categories Homework, Tests, and Final Project, and assign each the respective weights 20, 40, and 40. You do not have to include all of the categories in the final grade calculation. For example, if you don’t want to include scores from the Quizzes category, then you don’t need to add that category to the calculation.

Mixed Weighting

A combination of the calculations types listed above can also be selected within a single reporting term to produce a grade that is the weighted average of their respective grade values. When mixing calculation types, there is a good possibility of scores being double-counted. PowerTeacher Pro will double-count scores if the calculation is defined in a manner to do so. For example, if a calculation is defined using Total Points and Categories, any assignment that is part of the defined category will have the score double-counted within the calculation.

Traditional Grade Calculations

Use this page to define traditional grade calculations for PowerTeacher Pro if you have been permitted to make adjustments to the calculations set by the district. Checkmarks indicate which aspects of the calculation formula you have permission to change.

1. On the menu bar, click Settings, and then choose Traditional Grade Calculations.
2. Click the class, and then click the Edit icon next to the specific term. A lock icon next to the term indicates that the term is locked and the grade calculations for that term cannot be modified.
3. On the Formula tab, select the calculation type, attribute, and weight. Use weight values that will make the values in the Percent columns add up to 100%.
4. Click the plus sign (+) to add a type. Click the minus sign (-) next to a type to remove it.
5. To calculate the overall class grade using the formula, verify that **Calculate Overall Class Grade** is checked.

6. On the Drop Scores tab, select which lows scores to drop from the calculation.

7. Click **Save**.

---

**Copy Traditional Grade Calculations**

You can use the Copy Traditional Grade Calculation function to copy the grade calculation from a specific reporting term or from a class. Here are some things to keep in mind when copying the final grade calculations:

- A co-teacher can copy traditional grade calculations only when a lead teacher is the same for the source and target classes.
- You can copy to one or more reporting terms in the same class, with one exception. If the source reporting term uses term weighting, then the target reporting term must have the same place in the reporting term hierarchy.
- You can copy traditional grade calculations within a class, or to other classes.
- You cannot copy to reporting terms of the previous year's classes.
- You can copy grade calculations from a locked reporting term, but you cannot copy calculations to a locked reporting term.
- You cannot copy traditional grade calculations from PowerTeacher Gradebook.

---

1. On the Traditional Grade Calculations page, select the gear and choose **Copy Traditional Grade Calculations**.

2. Select one of the copy options:
   - **Within a Class** to copy the calculations to other reporting terms in the same class. For example, if you use category weighting, you can set it up once, and copy it to all other terms in the same class. Select the source class and reporting terms, and the target reporting terms from the menus provided.
     by default, the **Recalculate Final Grades** checkbox is selected. Deselect
the checkbox if you do not want the recalculation to occur.

- **To Another Class** to copy the calculations to other classes. For example, if you have 20 art classes, you can set up one class, then copy to every other class.
  
  Select the source and target class and reporting term from the menus provided.
  
  by default, the **Recalculate Final Grades** checkbox is selected. Deselect the checkbox if you do not want the recalculation to occur.

3. **Click Validate.** A Summary screen displays which calculations and dropped scores settings will be copied. **Note:** If Drop Low Sores has been configured for the calculation, they will only be copied if the calculation itself can be copied. If any reporting terms cannot be copied, an explanation is provided in the Info column.

4. **Click Copy.** The calculations are copied to the specified target classes and terms.

**Copying Dissimilar Reporting Term Structures**

When you attempt to copy classes that have dissimilar reporting term structures, you can successfully copy the calculations in the following two scenarios:

- Any reporting terms with the same name and structure are pre-matched. For example: If you attempt to copy a Y1 class that has lower-level reporting terms of S1, Q1, Q2 S2 Q3 Q4 into an S1 class with lower-level reporting terms S1, Q1, Q2 only, any reporting terms with the same name will be pre-matched automatically. It is assumed that you want the S1, Q1 and Q2 from the Y1 class to go to those same reporting terms in the S1 class.

- If no name matches are available, then PowerTeacher Pro looks for a structure match. For example, copying S1 (with lower-level terms Q1 and Q2) into S2 (with lower-level terms Q3 and Q4) is a perfect structure match. Both have one higher-level term and two lower-level terms.
Standards Grades Calculations

Set the calculation methods for standards grades for each class.

1. On the menu bar, click Settings, and then choose Standards Grade Calculations.
2. Click the triangle next to the class to expand the view.
3. Use the Default Calculation menu to choose the calculation method for the standards grades.
4. Click the Edit icon to set the number of recent scores to include in the Most Recent Scores calculation.
5. Select the Auto-Calculate checkbox to enable the automatic calculation of lower level standards into the higher level standards grades. Select an option from the pop-up menu to set the default calculation method for the higher level standards grade:
   - **Mean**: An average of the lower level standards grades.
   - **Median**: The middle value of the lower level standards grades.
   - **Mode**: The most frequently occurring grade of the lower level standards grades.
   - **Highest**: The highest grade of the lower level standards grades.
   - **Specific Weighting**: The weighted average of specific standards grades. The PowerSchool administrator sets the standards specific calculation and weights at the course level.
   - **Specific Sum**: The weighted sum of numeric grades for specific standards. This calculation is typically used by Middle Years Program, as part of the International Baccalaureate program. The PowerSchool administrator sets the standards specific calculation and weights at the course level. For example, four standards score on 1-8 scale can be summed up to calculate a final grade on a 1-32 scale using the Specific Sum calculation.
6. Click Save.

Standards Calculation Examples

Here are five example scores, an explanation of each calculation option, and a discussion of when each option might be a good or a bad choice for your class.
<table>
<thead>
<tr>
<th>Example Scores</th>
<th>Calculation Method</th>
<th>Calculated Score Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scores on five assignments: 2, 3, 3, 3, 4</td>
<td>Mean (average of the scores)</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Weighted Mean average of the scores, weighted by total value (points possible x weight)</td>
<td>3 (but depends on the weighted points possible for the assignments)</td>
</tr>
<tr>
<td></td>
<td>Median (middle score)</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Mode (most frequently occurring score)</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When there is more than one mode, this score will be the highest of the modes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Highest (highest score)</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Most Recent (average of the most recent scores)</td>
<td>Most Recent 1 score: 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Most Recent 2 scores: 3.5 (average of 3 and 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Most Recent 3 scores: 3.33 (average of 3, 3, and 4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can also set a weight for each of the most recent scores on the Preferences dialog.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, set the most recent calculation to use the last 3 scores. You want the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>most recent to be 50%, and the 2 before to each be 25% of the calculation.</td>
</tr>
</tbody>
</table>
Every measure has times when it is valuable, and times where it may not be the best measure for your class.

**Calculation Methods**

The following table lists the calculation methods available for analyzing assignment standards scores in order to calculate a final standards grade on a given standard.

<table>
<thead>
<tr>
<th>Calculation Method</th>
<th>When to Use It</th>
<th>When Not to Use It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>When you have equally important scores at each period of time, and the learning is not cumulative. For example, in History, final unit test scores on unit 1, unit 2, and unit 3 may all be independent. In that case, using the mean (or average) could be a good choice.</td>
<td>When students are introduced to a new concept and the learning is cumulative over time. For example, students start out not understanding a concept, but over the term they get it. Averaging their initial scores (where they were unfamiliar with the work) with their final attempts (when they understood the concepts) may not be the best measure. For example, consider the following scores: 20%, 30%, 40%, 95%, 100%. In this case, the student likely did not understand the concept at the beginning, but by the end they got it. The average here is 57%, which may not be the most reflective of their proficiency at the end of the term.</td>
</tr>
<tr>
<td>Weighted Mean</td>
<td>The weighted mean is better than the mean when assignments with high weighted points possible should be counted more heavily.</td>
<td>When all standards scores are valid indicators of performance, the teacher may not care about the specific points possible. This is especially true if there are high point value assignments from early in the semester, and the students have grown tremendously since that time.</td>
</tr>
<tr>
<td>Median</td>
<td>When you have multiple data points, and students have been given lots of chances to demonstrate mastery. It allows the student to overcome their initial attempts when they don’t understand at the beginning, because only the middle score is used. Some people consider this one of the most consistent measures of performance. This measure throws out high and low outlying scores. For this reason, housing price data is usually listed in terms of the median sales price. There are extremes at either end that can skew average.</td>
<td>When there are only a few data points. In that case, the middle number can simply be luck. Or, when the learning is cumulative, where the students know much more at the end of the term, and their proficiency is significantly better across the board than at the start. For example, consider the following scores: 20%, 30%, 40%, 95%, 100%. In this case, the student likely did not understand the concept at the beginning, but by the end they got it. The median (or middle number) here is 40%, and may not be the most reflective of their proficiency at the end of the term.</td>
</tr>
<tr>
<td>Mode</td>
<td>When you have a small range of possibilities. For example, when using letter grades A,B,C,D,F, or a 1-4 scale, there are only a limited range of score options. If a student’s scores are A, D, A, B, A, the most frequently occurring value is A.</td>
<td>When there are multiple possible scores, and it is unlikely for the exact score to be consistent. For example, this is not a good measure for percentage scores. Example percentage scores: 90, 91, 25, 100, 99, 81.5, 98, 97, 25, 96, 94. In this data, the mode is 25%. The average is 81.5%. The median is 94%.</td>
</tr>
<tr>
<td>Highest</td>
<td>When the student’s highest level of demonstrated proficiency is a good indicator of what they know and can do. When assessments are in-depth and highly reliable. In these cases, many districts believe that the student’s highest score is a good indicator.</td>
<td>When the highest score could be based on chance or lucky guessing. For example, on multiple choice tests, the student could have guessed right on several questions by chance, boosting their highest score. For example, one student’s results for one standard assessed on 5 multiple choice tests were as follows: 70, 95, 70, 70, 70.</td>
</tr>
</tbody>
</table>
Although the student did get a 95 once, this score may not be the best reflection of the student’s actual level of proficiency on this standard.

<table>
<thead>
<tr>
<th>Most Recent</th>
<th>When the learning is cumulative, and the students will demonstrate a much higher level of proficiency at the end of the term than at the beginning. In these cases, it makes sense to focus on the most recent scores as a reflection of the student’s proficiency.</th>
</tr>
</thead>
<tbody>
<tr>
<td>When some of most recent scores themselves are anomalies. For example, if a student recently was very ill, or experienced some other phenomenon, then the most recent scores may not be reflective of their actual proficiency. This is usually assessed student by student to determine if the most recent scores are accurate. It can also happen when the most recent assessment is not as detailed or reliable as earlier assessments, or there were other distracting factors. For example, students have lots of good quizzes and a unit test with reliable data. That was followed by in-class review worksheets. Half of the students were distracted completing them because there was construction going on outside. In this case, the most recent data may not be the most reflective.</td>
<td></td>
</tr>
</tbody>
</table>

**Important Usage Note**: In PowerTeacher Pro, you can mark any standards score as Exempt. For example, if a student was ill during the last quiz, you can choose to exempt this score. The calculations will then ignore that score and use the other scores. For example, if you have set the most recent three calculation, and you mark the most recent score as Exempt, the calculation will take the previous three scores. In this manner, you can use the most recent scores, or any other calculation, while still exempting any scores that are not an accurate reflection of the student’s learning.